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What's New in DBArtisan XE6

New features for this release fall into the following categories:

(o]

(¢]

o

PostgreSQL Object Management

PostgreSQL Utilities

PostagreSQL Tools Menu Updates

PostgreSQL Updates to the SQL Editor

Welcome Window

Project Management, Version Control, and Script Library

Datasource Reqistration Updates

Trace File Logging Options

DBMS Platform Updates

Explorer and Database Monitor Updates

ISQL Windows Backup

Connectivity Improvement

Performance Analyst for SQL Server Improvements

Java Update
Improved Multi-Monitor Support

PostgreSQL Object Management

What's New in DBArtisan XE6

The following topics describe PostgreSQL object management updates for this release.

Object Wizards/Editors

You can now create and edit objects of the following types: check constraints, domains, exclusion
constraints, foreign keys, functions, indexes, primary keys, roles, rules, schemas, tables,
tablespaces, triggers, unique keys, and views.

Refresh Materialized View Object Action

A new Refresh Materialized View action is available against views created using the CREATE
MATERIALIZED VIEW statement. It lets you build and submit a REFRESH MATERIALIZED VIEW
statement. Simple default behavior replaces the contents of a materialized view. If With No Data is
selected, no new data is generated and the materialized view will be in an unscannable state.

Embarcadero Technologies



What's New in DBArtisan XE6

[ |

Refresh Materialized View

Action Options 1 object(s] to refresh

Dependencies

"Corina”."AvV122" Eg: il
4 Refresh Materialized View
With No Data |

Preview

With No Data

No new data is generated and the materialized view is
left in an unscannable state.

Preview ji Schedule ‘j < Back l Next > ‘ I Execute |[ Cancel j \ Help

Datasource Explorer Performance Node

A Performance node is now available in the Datasource Explorer. As with other DBMS platforms,
the PostgreSQL Performance node has Locks and Processes subnodes. A Prepared Transactions
subnode provides details on transactions that have been prepared for two-phase commit.

() PostgreSQL Servers
ﬁ ROMLABARTPGI3_1 (PostgreSQL 9.3.4)
B Filters
T Server
'ty Databases
Version
(G Logs (233)
& Storage
&” Security
i Schema
E1 Performance
3 Processes
(3 Locks
& Prepared Transactions

The new Server > Logs node provides access to logfiles. A Rotate Log action signals the log-file

manager to immediately switch to use of a new output file.

PostgreSQL Utilities

Data and Schema Utilities

The following Utilities menu features are now available against PostgreSQL datasources:

o Database Monitor provides details on locks, processes, and prepared transactions.

o Data Load lets you load data from a file.
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o Data Unload lets you generate a pgadmin export data call, dumping database data to a
file.

o Database Backup generates a pg_dump script, backing up one or more tables or views of
a database.

o Database Restore generates a pg_restore operation, restoring tables or view data from a
previous backup.

o Schema Extraction walks you through the process of building an extraction script,
executing it for storage of the database or object schema in a file.

o Schema Migration migrates schema and table data from one DBMS platform to another.

o Schema Publication lets you generate HTML reports documenting the details of your
schema, databases, and database objects.

o Reverse Engineering lets you analyze, control, and document existing database objects.

Database Monitor

DBArtisan now offers the Database Monitor against PostgreSQL datasources. Similar to Database
Monitor for other DBMS platforms, Locks and Processes tabs are available in the Data base
Monitor. A new Prepared Transactions tab is also available against PostgreSQL datasources. It
displays identification details for transactions that have been prepared for two-phase commit. The
following pg_prepared_xacts table columns are displayed for each transaction: transaction ID,
global ID, date and time that the PREPARE TRANSACTION statement was executed, and the
owner and database associated with the transaction. When this tab is active, the toolbar lets you
Commit and Rollback a selected transaction.

@ Refresh Rate (seci: |90 * 3 Commit Rollback ‘z Refresh kEGose

XID Global ID Time Owner Database

e = S e . i
1723 trx3 2013-05-07 04:19:45.99662-07 postgres postgres
1730 trx4 2013-05-07 04:30:54.648643-07 chiru2 postgres

PostgreSQL Tools Menu Updates

The following Tools menu features are now available against PostgreSQL datasources:

o Database Search lets you search for objects whose DDL contains a specified character
string, across multiple databases.

o Query Builder lets you construct, structure, and manipulate queries using a graphical
interface.

o Data Editor lets you edit table data in real time.
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PostgreSQL Updates to the SQL Editor

The Paste SQL Syntax and Paste SQL Statement features are now available against PostgreSQL
datasources.

-~

# ' SQL Syntax for PostgreSQL =B8] 8 ,'
SQL Statements: Syntax:
5 SQL Syntax i

@ [ Conditionals
+ [ SQL Commands
# [ Functions

r ™y
B Paste SQL ‘-': - (=l - X
Datasource ROMLABARTPGS: ~ ‘ Cancel \
Database ¥ r .
= ‘ Help \
Owner All Owners = : "
Object Type | Tables v (® Select (O Update O lnset () Delete
SELECT Statement
Tables “ || Columns o
i

[] 123456.test

["] Corina.Corinaaaa

[~] Corina. TRIGGER _TABLE
[ Corina.bases4

[T Corina.ceiling

[~ Corina.mosteni1

- A

Welcome Window

The Welcome Window helps customers to get information about product features, news and
upcoming events. This window also includes direct links to useful DBArtisan features like New
Project, Open Project or links to Recent Datasources.

Project Management, Version Control, and Script Library

DBArtisan Project Management Support

DBArtisan project management facilities act as a repository to maintain all source code for a
database project. When you create a new project (File > New > Project), you can initialize the
project using one of four methods:

o From an existing database

o From one or more files (SQL/query scripts, DDL files, ER/Studio files, procedures, Java,
Javascript or VB Script files, or text or HTML files)

o From a version control project
o Uninitialized.

A project opens in a dedicated Project window.
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Project
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In addition to basic project operations (New, Open, Close), Project menu and right-click options
provide basic file and folder options. Other key options let you

o Specify a build order for your project scripts

o Execute the build.

DBArtisan Version Control Support

The Project menu also provides access to version control support, also new for this release of
DBAtrtisan. Basic version control functions are provided: Get Latest Version, Check In, Check Out,
Undo Check Out, Add to/Remove From Version Control, Show History, Show Differences,
Version Control Properties, Share From Version Control, and Refresh Status.
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PROJECT
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24 Build Order...
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Support is provided for any source control product that uses the MSSCCI plug-in interface.

Note: For the 64-bit version of DBArtisan, a 32-bir version of the MSSCCI provider
can be used for version control access. The feature is controlled for the Options
Editor's Version Control tab (File > Options > General > Version Control).

Script Library

The Script Library (View > Script Library) provides a drag-and-drop library interface of all
supported DBMS syntax, SQL syntax, built-in functions, optimizer hits, and SQL-conditional syntax.
Additionally, it provides the ability to create custom folders to store commonly-used code for quick
and efficient access or execution, as needed.

Datasource Registration Updates

For connectivity purposes, DBArtisan is packaged with a native driver as well as a set of one or
more JDBC drivers for each DBMS platform. In previous releases, the native driver for each
platform was the default connection option when registering a datasource.

This release introduces two enhancements:

o You can now designate one of the JDBC drivers as the default connectivity option for a
DBMS platform.

o You can universally change the definition for all existing, currently unconnected datasources
for a platform to use either the native driver or a JDBC driver as the connection option.
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In the Options Editor, the Connections page now has a tab corresponding to each supported
DBMS platform. The Default Driver Selection group of settings provides the new functions.

™

-
Options = |

IT)'De filter text MySQL Connection Settings

). Connection
Apache Hive Default Driver Selection

-DB2 [[] Connect using JDBC instead of the MySQL Connector/ODBC driver
MySQL
Oracle
PostgreSQL
SQL Azure
SQL Server
Sybase
Sybase IQ

.. Team Server

JDBC driverto use: -

Assign to all disconnected Datasources

| ok || cancel || Hep |

%

For DBMS platforms with a native driver and one or more JDBC drivers packaged, the Connect
using... and JDBC driver to use controls enable selection of a JDBC driver as the default
connection option and let you select a JDBC driver. The Assign to all disconnected Datasources
control assigns the selected JDBC driver as the connection option for all disconnected datasources
for the current platform, if the Connect using... control is selected. Otherwise it assigns the native
driver as the connection option for all disconnected datasources for the current DBMS platform

Trace File Logging Options

As a new diagnostic tool, you can now generate a trace file consisting of the sequence of
application event messages. The Options Editor’s Logging page now lets you activate and
deactivate, specify a location for, and select a severity level of messages logged.

Trace Path: C:\Users\davidt\AppD ata\Roaming\Embarcadero\Logs ol

Trace Level:  Qff v Truncate...

In descending order of severity (and ascending order of total messages logged), Trace Level
options are Fatal Errors, Errors, Warning, Info, Debug, Trace, and Max.

DBMS Platform Updates

The following topics describe DBMS platform and version updates for this release.

o Sybase IQ 16 - Functionality available for previous Sybase 1Q releases is now available
against Sybase 1Q 16 datasources.

o Apache Hive - This release presents a technical preview of Apache Hive support. As with
other technical previews, minimal functionality is provided. Features include datasource
registration and connection, a minimal Navigator/Explorer tree, and a minimal set of object
management features.
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Explorer and Database Monitor Updates

Improved numeric column filtering in Explorer and Database Monitor. Users can now filter
numeric columns by using operators (>,=,<,<=,>=). When no operator is used, >= is assumed.

ISQL Windows Backup

For Windows Vista and higher, the auto save feature of DBArtisan is now connected to the Restart
Manager. Also, unlike the previous version (o Windows XP) all modified ISQL windows will have a
backup saved at a regular interval, even those ISQL windows that do not have a file name
associated with them. In the event of a crash, those ISQL windows will automatically open up on
the next restart. If the Restart Manager is able to detect the crash, it will attempt to automatically
restart the application for you. On Windows XP, this feature will function as it did in past versions.

Connectivity Improvement

Connectivity has been improved to have a central location in the options page to set the driver for
all datasources of a certain type to use. An individual datasource can override this setting, but by
default all datasources will obey the global setting. No longer will customers have to change each
individual datasource if they want to use a particular driver for their system.

Performance Analyst for SQL Server Improvements

Performance Analyst improves the space usage functionalities adding information about the
database and object that are taking up the most space on the system.

Java Update

DBArtisan has updated to Java 1.7.

Improved Multi-Monitor Support

Users can now detach any MDI tab from the main application window. They can group these
detached tabs togetther or keep them separate.
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